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Safety and Common Symbols

The following safety and common symbols may be used in this manual and on

the equipment:

Symbol Description
DANGER indicates a hazard with a high level of risk which, if not
A DANGER avoided, will result in death or serious injury.

WARNING indicates a hazard with a medium level of risk which,
| A WARNING | if not avoided, could result in death or serious injury.

CAUTION indicates a hazard with a low level of risk which, if not
| A CAUTION | avoided, could result in minor or moderate injury.

CAUTION used without the Caution, risk of danger sign A\,
| CAUTION | indicates a hazard with a potentially hazardous situation which,

if not avoided, may result in property damage.

Caution, risk of electric shock

Caution, hot surface

Caution, risk of danger

Caution, lifting hazard

Caution, hand entanglement hazard

Notice, non-ionizing radiation

Direct current

Alternating current

Both direct and alternating current

slale |l BB BB P

Three-phase alternating current

L

Earth (ground) terminal

© Festo Didactic 39866-10



Safety and Common Symbols

Symbol

Description

Protective conductor terminal

Frame or chassis terminal

D
A+
v

Equipotentiality

On (supply)

Off (supply)

Equipment protected throughout by double insulation or
reinforced insulation

In position of a bi-stable push control

Db OO —

Out position of a bi-stable push control

© Festo Didactic 39866-10
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Preface

Digital communication offers so many advantages over analog communication
that the majority of today’s communications systems are digital.

Unlike analog communication systems, digital systems do not require accurate
recovery of the transmitted waveform at the receiver end. Instead, the receiver
periodically detects which waveform is being transmitted, among a limited
number of possible waveforms, and maps the detected waveform back to the
data it represents. This allows extremely low error rates, even when the signal
has been corrupted by noise.

The digital circuits are often implemented using application specific integrated
circuits (ASIC) and field-programmable gate arrays (FPGA). Although this
“system-on-a-chip” approach is very effective for commercial and military
applications, the resulting systems do not allow access to internal signals and
data and are therefore poorly suited for educational use. It is for this reason that
we designed the Communications Technologies Training System.

The Communications Technologies Training System, Model 8087, is a state-of-
the-art communications training system. Specially designed for hands-on
training, it facilitates the study of many different types of digital
modulation/demodulation technologies such as PAM, PWM, PPM, PCM, Delta
Modulation, ASK, FSK, and BPSK as well as spectrally efficient technologies
such as QPSK, QAM, and ADSL. The system also enables the study of direct-
sequence and frequency-hopping spread spectrum (DSSS and FHSS), two key
technologies used in modern wireless communication systems (CDMA cellular-
telephony networks, Global Positioning System, Bluetooth interface for wireless
connectivity, etc.) to implement code-division multiple access (CDMA), improve
interference rejection, minimize interference with other systems, etc. The system
is designed to reflect the standards commonly used in modern communications
systems.

Unlike conventional, hardware-based training systems that use a variety of
physical modules to implement different technologies and instruments, the
Communications Technologies Training System is based on a Reconfigurable
Training Module (RTM) and the Communications Technologies (LVCT) software,
providing tremendous flexibility at a reduced cost.

Each of the communications technologies to be studied is provided as an
application that can be selected from a menu. Once loaded into the LVCT
software, the selected application configures the RTM to implement the
communications technology, and provides a specially designed user interface for
the student.

The LVCT software provides settings for full user control over the operating
parameters of each communications technology application. Functional block
diagrams for the circuits involved are shown on screen. The digital or analog
signals at various points in the circuits can be viewed and analyzed using the
virtual instruments included in the software. In addition, some of these signals
are made available at physical connectors on the RTM and can be displayed and
measured using conventional instruments.

The courseware for the Communications Technologies Training System consists
of a series of student manuals covering the different technologies as well as
instructor guides that provide the answers to procedure step questions and to

© Festo Didactic 39866-10



Preface

review questions. The Communications Technologies Training System and the
accompanying courseware provide a complete study program for these key
information-age technologies.

We invite readers of this manual to send us their tips, feedback, and
suggestions for improving the book.

Please send these to did@de.festo.com.

The authors and Festo Didactic look forward to your comments.
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About This Manual

Manual Objective

When you have completed this manual, you will be familiar with the principles of
QAM modulation and demodulation. You will be familiar with the use of
differential QAM (DQAM), which uses V.22 bis encoding to overcome phase
ambiguity, and with the use of data scrambling to ensure frequent transitions in
the modulated signal. You will also be able to troubleshoot instructor-inserted
faults in the QAM/DQAM application.

Description

This Student Manual begins with an Introduction presenting important
background information. Following this are a number of exercises designed to
present the subject matter in convenient instructional segments. In each
exercise, principles and concepts are presented first followed by a step-by-step,
hands-on procedure to complete the learning process.
Each exercise contains:

e Aclearly defined Exercise Objective

e A Discussion Outline listing the main points presented in the Discussion

e A Discussion of the theory involved

e A Procedure Outline listing the main sections in the Procedure

o A step-by-step Procedure in which the student observes and measures
the important phenomena, including questions to help in understanding
the important principles.

e A Conclusion

e Review Questions

“J In this manual, all New Terms are defined at the end of the Introduction. In
7 addition, an Index of New Terms is provided at the end of this manual.

Because the theory of QAM is similar to that of QPSK, some parts of the
N7 Discussions in this manual are similar to the Discussions in the student manual
Quadrature Phase Shift Keying (QPSK/DQPSK), part number 39865-10.

Preparation

Before beginning this manual, it is preferable to be familiar with the following
topics:

e Pseudorandom binary sequences (PRBSs), also called pseudorandom bit
sequences, n-sequences or maximum-length sequences — their time-
domain and frequency-domain characteristics.

e Quadrature phase shift keying (QPSK) — the generation and demodulation
of QPSK signals and their time-domain and frequency-domain
characteristics.

© Festo Didactic 39866-10 Xl



About This Manual

Safety considerations

Safety symbols that may be used in this manual and on the equipment are listed
in the Safety Symbols table at the beginning of the manual.

Safety procedures related to the tasks that you will be asked to perform are
indicated in each exercise.

Make sure that you are wearing appropriate protective equipment when
performing the tasks. You should never perform a task if you have any reason to
think that a manipulation could be dangerous for you or your teammates.

Systems of units

Units are expressed using the International System of Units (SI) followed by units
expressed in the U.S. customary system of units (between parentheses).

XV © Festo Didactic 39866-10



Colored sidebars
contain comple-
mentary infor-
mation that will
be of interest to
the reader.

Conventions Used in This Manual

Special character formats
New terms are shown in bold colored characters the first time they appear.

Important terms are shown in bold colored characters the first time they
appear.

Notes provide details that should be noted by the reader.

Y

\(2‘ Tips provide information on effectively using the system. These are particularly
helpful for inexperienced users.

IL!!J This symbol refers you to another manual or document.

Software commands and dialog box names are shown in color. “Choose File »
Print’” means choose the Print command in the File menu.

Probe connections

Instrument probe connections to test points are usually presented in tables
showing the type of probe to use, the test point (TP) to connect it to, and the
signal present at that test point:

Oscilloscope probe | Connect to Signal
1 TP1 DATA INPUT
TP2 CLOCK INPUT
E TP3 BSG SYNC. OUTPUT

© Festo Didactic 39866-10
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Conventions Used in This Manual

System and instrument settings

Unless you are instructed to make specific settings, you can use any system and
instrument settings that will allow you to observe the phenomena of interest. As a
guide, important settings that were used to produce a figure may be shown
beside the figure.

Generator Settings:
Bit Rate

I

i Nnn
JUUUY U

HENEE

Il l—| M i |—| I
U YU LU

N

NN
IJ |_| I |

Oscilloscope Settings:
Channel ...
Channel 2.......
Channel E.......
Time Base......
Trigger: Slope
Trigger: Level
Trigger: SOUCe .........uvrvmrurerecrenes Ext

l_| 1 1 l—| 1 1
] | NN
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List of Equipment Required

The following equipment is required to perform the procedures in this manual:

QTY DESCRIPTION MODEL
1 Power Supply 9408
1 Reconfigurable Training Module 9431
1 Data Acquisition Interface 9466
1 Analog/Digital Output Interface 9467
1 LVCT Software 9432-0
1 QPSK/QAM/ADSL Applications 9432-4
1 Cables and Accessories 9483

Additional Equipment

The LVCT software requires a current model computer running Windows®
operating system. An Ethernet (100 Mb/s or better) network interface adapter is
also required. A dual-output video adapter and two monitors are recommended
to allow viewing the diagrams and the virtual instruments simultaneously.

J7 The Communications Technologies Host Computer, Model 9695-A0, meets or
N exceeds these requirements.

Optional Equipment

You may wish to use a conventional oscilloscope (Model 797-20 or equivalent)
and/or spectrum analyzer to observe the signals available at the BNC connectors

and test points on the RTM (refer to the RTM Connections tab of the software to
identify these outputs).

© Festo Didactic 39866-10 XVII






To the Instructor

You will find in this Instructor Guide all the elements included in the Student
Manual together with the answers to all questions, results of measurements,
graphs, explanations, suggestions, and, in some cases, instructions to help you
guide the students through their learning process. All the information that applies
to you is placed between markers and appears in red.

Accuracy of measurements

The numerical results of the hands-on exercises may differ from one student to
another. For this reason, the results and answers given in this manual should be
considered as a guide. Students who correctly performed the exercises should
expect to demonstrate the principles involved and make observations and
measurements similar to those given as answers.

© Festo Didactic 39866-10 XIX
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Exercise ]

QAM Modulation

EXERCISE OBJECTIVE

DISCUSSION OUTLINE

DISCUSSION

QAM is a type of M-ary
signaling with M equal to
the number of different
symbols.

With 16-QAM, there are
sixteen different symbols
(quadbits):

0000 0001 0010 0011
0100 0101 0110 0111
1000 1001 1010 1011
1100 1101 1110 1111

Each quadbit is represented
by different modulation
symbol (combination of
phase and amplitude).

© Festo Didactic 39866-10

When you have completed this exercise, you will be familiar with QAM
modulation, with the characteristics of QAM signals and with the QAM signal
constellation. You will also be familiar with the LVCT software and the use of the
virtual instruments.

The Discussion of this exercise covers the following points:

=  The QAM waveform

=  QAM constellations

= A typical QAM modulator

= Symbol rate and bandwidth
The QAM waveform

Quadrature Amplitude Modulation or QAM (pronounced ‘kwam”) is a digital
modulation technique that uses the data to be transmitted to vary both the
amplitude and the phase of a sinusoidal waveform, while keeping its frequency
constant. QAM is a natural extension of binary phase shift keying (BPSK) and
quadrature phase shift keying (QPSK), both of which vary only the phase of the
waveform.

The number of different waveforms (unique combinations of amplitude and
phase) used in QAM depends on the modem and may vary with the quality of the
channel. With 16-QAM, for example, 16 different waveforms are available.
64-QAM and 256-QAM are also common. 16,384-QAM is possible in ADSL
modems. In all cases, each different waveform, or amplitude-phase combination,
is a modulation symbol that represents a specific group of bits.

The LVCT Quadrature Amplitude Modulation (QAM/DQAM) application uses
16-QAM. In the modulator, consecutive data bits are grouped together four at a
time to form quadbits and each quadbit is represented by a different modulation
symbol. In the demodulator, each different modulation symbol in the received
signal is interpreted as a unique pattern of 4 bits.

Figure 4 shows all 16 QAM modulation symbols superposed on the same axes.
Four different colors are used in the figure and each color is used for four
different waveforms. Each waveform has a different combination of phase and
amplitude.



Exercise 1 — QAM Modulation ¢ Discussion

The Gray code was de-
signed by Bell Labs re-
searcher Frank Gray and
patented in 1953. Gray
codes are widely used in
digital communications.

10

NeYa Yo A%
%% Q% 9%
DRI
DS
VS INSENSNL SN

Figure 4. All QAM modulation symbols for 16-QAM.

XA

QAM constellations

Figure 5 shows the constellation diagram for 16-QAM. The constellation diagram
is a pictorial representation showing all possible modulation symbols (or signal
states) as a set of constellation points. The position of each point in the diagram
shows the amplitude and the phase of the corresponding symbol. Each
constellation point corresponds (is mapped to) to a different quadbit.

Q
[ ] [ ] [ ] [ ]
[ ] [ ] [ ] [ ]
/
[ ] [ ] [ ] [ ]
[ ] [ ] [ ] [ ]

Figure 5. 16-QAM constellation (4-bits per modulation symbol).

Although any mapping between quadbits and constellation points would work
under ideal conditions, the mapping usually uses a Gray code to ensure that the
quadbits corresponding to adjacent constellation points differ only by one bit.
This facilitates error correction since a small displacement of a constellation point
due to noise will likely cause only one bit of the demodulated quadbit to be
erroneous.

© Festo Didactic 39866-10



Exercise 1 — QAM Modulation & Discussion

A typical QAM modulator

A QAM signal can be generated by independently amplitude-modulating two
carriers in quadrature (cos ot and sin wt), as shown in Figure 6.

MSB | Channel
Quadbits [* Dbt | Gomerter [~ Fiter
Binary (dibit pairs) > liter
Data M%D LSB QAM Signal
Serial to *
—m{» Parallel S A Four-level Bi-phase,
Converter |1 analog signals cosot  pijevel signals
iy 16 states
LSD MSB (4 phases,
— > D/A Low-Pass 4 levels)
Dibits .| Converter Filter
LSB Q Channel
sin ot

Colors (red, green, blue, and
violet) are used in the data
bit stream to help distinguish

Figure 6. Simplified block diagram of a QAM modulator.

The Serial to Parallel Converter groups the incoming data into quadbits. Each
time four bits have been clocked serially into its buffer, the Serial to Parallel
Converter outputs one quadbit in parallel at its four outputs.

The starting point for grouping bits into quadbits is completely arbitrary. Figure 7
shows an example using the repeating 12-bit binary sequence 10000000 0000.
In this figure, the grouping initially starts at the beginning of the sequence

the individual bits. . : . .
(Condition A). The first quadbit at the output is 1000 followed by two all-zero
quadbits 0000. Then the quadbit pattern repeats.
Serial to Parallel
Converter Quadbits Out (parallel)
10010010000000000O0 ..
b 0
e TP6
Data Bits In (serial) il 00000000000O00O0O0OOO .. 0
100000000000 10000000 oooo...=,:,:' _______ TP7
P4 \\: _______ p| 000000000000000000. o
- 5 hAISY TP8
Time <,/ 000000001001001001 .. o
Drop 1 Bit Condition A Condition B TP9

One bit dropped

Figure 7. Serial to Parallel Converter operation with repeating sequence 1000 0000 0000.

© Festo Didactic 39866-10

In the QAM/DQAM application, the Drop 1 Bit button is included in the Serial to
Parallel Converter for educational purposes. Clicking this button causes the
Serial to Parallel Converter to ignore one bit in the data sequence. This changes
the grouping of all subsequent data bits into quadbits (see Condition B in
Figure 7).
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Exercise 1 — QAM Modulation ¢ Discussion

In the QAM/DQAM applica-
tion, the MSB input of the
D/A Converter determines
the sign of the output volt-
age and the LSB input de-
termines the magnitude of
the output voltage.

Orthogonal signals can be
summed, transmitted in a
channel and (theoretically)
perfectly separated in the
demodulator without any
mutual interference.

12

Each quadbit consists of a pair of dibits, which can be called the most significant
dibit (MSD) and the least significant dibit (LSD). The MSD is sent to the I-channel
of the modulator; the LSD is sent to the Q-channel of the modulator. Each
channel of the modulator works independently to processes the data it receives.

The D/A Converter in each channel converts the dibit stream into a (baseband)
four-level pulse stream that can be applied to one input of the mixer. Each of the
four levels represents a specific dibit. The four levels used are proportional to -3,
-1, +1, and +3. This makes the distribution of the constellation points uniform.

To restrict the bandwidth of the QAM signal, a low-pass filter is usually used
before the mixer in each channel of the modulator in order to provide the desired
spectral shaping. In addition, a bandpass filter (not shown in Figure 6) may be
used to filter the QAM signal before transmission.

Each mixer performs modulation by multiplying the sinusoidal carrier by the four-
level data signal. Multiplying the carrier by +1 causes a 180° phase shifts in the
mixer output signal and is equivalent to BPSK modulation. Multiplying by +3
causes a three-fold increase in peak amplitude and is essentially a type of ASK
modulation. Multiplying the carrier by -3 causes a 180° phase shift and a three-
fold increase in peak amplitude. The mixer output signal is therefore a bi-phase,
bi-level sinusoidal signal. The effect of the mixer is to shift the frequency
spectrum of the baseband signal up to the frequency of the carrier.

Table 2 shows the mapping used in the QAM/DQAM application from dibit to
relative pulse level (shown in brackets) and the resulting waveforms. In this
mapping, the first bit (MSB) of each dibit determines the phase of the mixer
output signal and the second bit (LSB) determines the amplitude.

Table 2. Mapping of dibit to pulse level to waveform in one channel of the modulator.

Dibit, (Relative Pulse Level), and Waveform
00 (+1) 01 (+3)
//\\\ Ve
N4 N
10 (-1) 11 (-3)
/N B
‘\\7/// /

The two bi-phase, bi-level signals are summed to produce the QAM signal.
Because these two bi-phase, bi-level signals are generated using orthogonal
carriers (in phase quadrature), the signals themselves are orthogonal, and the
QAM demodulator will be able to demodulate them separately.

© Festo Didactic 39866-10



Exercise 1 — QAM Modulation & Discussion

By convention, the ampli-
tude levels used in the
pulse streams d(f) and dq(t)
are proportional to £1, £3,
+5, ..., up to the number
of different levels re-
quired for the type of
QAM used. This makes
the distribution of the con-
stellation points uniform and
ensures optimal error per-
formance in the presence of
noise.

© Festo Didactic 39866-10

The output signal of the modulator is a sinusoidal carrier with 16 possible states,
each of which represents a four-bit symbol (quadbit). This signal can be
represented by Equation (3).

s(t) =d,(t) cos(mt)+ dg(t) sin(at) (3)
where s(f) is the QAM signal waveform
di(t) is the I-channel four-level pulse stream do, d2, ds ...
do(t) is the Q-channel four-level pulse stream d1, ds, ds ...
w is the angular frequency

Symbol rate and bandwidth

With 16-QAM, each symbol represents four bits. Therefore the rate that the
symbols occur in the QAM signal (the symbol rate) is one quarter the bit rate.
Table 3 compares the symbol rates (and bandwidths) for BPSK, QPSK, and
QAM.

Table 3. Symbol rates and bandwidths.

Modulation | Bits per symbol | Symbol rate vs. Bit rate | First-nulls bandwidth
BPSK 1 RS = Rb 2Rb
R
QPSK 2 R, =2 R,
2
R R
QAM 4 R, = —2% b
4 2

The bandwidth of a modulated signal depends on the rate of change in the signal
(i.e. the symbol rate) and not on the magnitude of each change. For this reason,
QAM requires one-half as much bandwidth as QPSK and one-quarter as much
as BPSK for a given bit rate. This is illustrated in Figure 8, where f: is the carrier
frequency. Alternatively, using QAM instead of QPSK or BPSK can double or
quadruple the bit rate for a given signal bandwidth.

Figure 8 shows that, for the same bit rate, the first-nulls bandwidth of a QAM

signal is one-half that of a QPSK signal, and one quarter that of a BPSK. Of the
three modulation techniques, QAM has the highest bandwidth efficiency.

13



Exercise 1 — QAM Modulation ® Procedure Outline

BPSK

QPSK

16-QAM

PROCEDURE OQUTLINE

14

Bandwidth

fc—2Rb fc—Rb fc fc+Rb fc+2Rb
Bandwidth

fc—4Rs fc—l3Rs fc—IZRs fc—'Rs flc fc+le fc+éRs fc+éRs fc+21Rs
Bandwidth

fc—8Rs fc—l6Rs fc—l4Rs fc—ﬁRs flc fc+l2Rs fc+4lle fc+éRs fc+éRs

Figure 8. BPSK, QPSK, and 16-QAM magnitude spectrum (for equal bit rates).

The Procedure is divided into the following sections:

= Set-up and connections

=  Observing binary sequences using the virtual instruments
= The Serial to Parallel Converter

= D/A Converter

= The Filters and mixers

=  The summer

=  Signal constellations
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PROCEDURE Set-up and connections

1. Turn on the RTM Power Supply and the RTM and make sure the RTM power
LED is lit.

e

File > Restore Default Settings Start the LVCT software. In the Application Selection box, choose
returns all settings to their QAM/DQAM and click OK. This begins a new session with all settings set to

default values, but does not their default values and with all faults deactivated.
deactivate activated faults.

(RS

-,(21 If the software is already running, choose Exit in the File menu and restart
LVCT to begin a new session with all faults deactivated.

3. Make the Default external connections shown on the System Diagram tab of
the software. For details of connections to the Reconfigurable Training
Module, refer to the RTM Connections tab of the software.

Q~ Click the Default button to show the required external connections.

4. As an option, connect a conventional oscilloscope to the BSG CLOCK
OUTPUT and the BSG DATA OUTPUT, using BNC T-connectors. Use the
BSG SYNC./4 OUTPUT as an external trigger.

Q~ On-line help is accessible from the Help menu of the software and the Help
menu of each instrument.

You can print out the screen of any instrument by choosing File » Print in that
instrument.

Observing binary sequences using the virtual instruments

5. Make the following Generator settings:

Generation Mode..........ccccoeeeeviiieiiieeeeeeeeeeen, Pseudo-Random

3 4

Bit RAtE.....uvvvevveeriiiiiriiiiiiiiiiiiiiiveenaneaes 2000 bit/s
Settings

This application has tables of settings that allow you to change various software
parameters in order to configure the system. Two Settings tables are provided —
QAM Settings and Generator Settings. By default, these tables are located at the
right side of the main window and only one of these tables is visible at a time.
Two tabs at the bottom allow you to select which table is visible and the name of
the visible table is displayed at the top. (Refer to on-line help for more
information.)

Settings tables have two columns. The name of each setting is shown in the left
column and the current value of each setting is shown in the right column. The
column separator can be moved using the mouse, and the entire table can be
resized as desired.

© Festo Didactic 39866-10 15
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Some settings have a drop-down list of possible values. To change this type of
setting, click the setting and then click the down arrow to display the drop-down
list and select a new value. You can also click the setting and then roll the mouse
wheel to change the value or repeatedly double-click the setting to cycle through
the available values.

To change an editable numerical setting, simply select or delete the current value
in the settings table, type a new value and press Enter or Tab. You can also click
the setting and roll the mouse wheel. When fine adjustments are possible,
holding down the Ctrl key on the keyboard while rolling the mouse wheel will
change the value by small increments.

When you change the value of a numerical setting, the focus remains on that
setting until you click elsewhere in the software. To immediately change the
setting to another value, you can simply type the new value and press Enter.

6. Click the QAM Modulator tab in order to display the QAM Modulator diagram.

Show the Probes bar (click #® in the toolbar or choose View » Probes Bar).
Connect the probes as follows:

Oscilloscope probe Connect to Signal
1 TP2 CLOCK INPUT
TP1 DATA INPUT
E TP3 BSG SYNC. OUTPUT
Logic Analyzer probe Connect to Signal
C TP2 CLOCK INPUT
1 TP3 BSG SYNC. OUTPUT
2 TP1 DATA INPUT
Other probes Connect to Signal
Spectrum Analyzer TP1 DATA INPUT

-,(21 To move a probe from the Probes bar to a test point, click the probe, move the
mouse until the tip of the probe is over the test point, and click the mouse
button to connect the probe.

To move a probe from one test point to another, move the mouse pointer over
the probe until the pointer changes into a grasping hand @ Then, click the
probe and, without releasing the mouse button, drag the probe to another test
point. Release the mouse button.

7. Show the Oscilloscope (click in the toolbar or choose Instruments »
Oscilloscope). Figure 9 shows an example of settings and what you should
observe.
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Generator Settings:
Generation Mode.......Pseudo-Random

Oscilloscope Settings:

Channel 1. 5 Vidiv
Channel 2. 5 Vidiv
Channel E ..o 5 Vidiv
Time Base.........
Trigger: Slope ...
Trigger: Level.... .
Trigger: SOUICE .......c.verurreeeerreeneenes Ext

© Festo Didactic 39866-10

Unless you are instructed to make specific settings, you can use any system
and instrument settings that will allow you to observe the phenomena of
interest. As a guide, important settings that were used to produce a figure may
be shown beside the figure.

A
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Figure 9. Clock, Sync. and PRBS data signals.

- Some settings have a drop-down list of possible values. To change this type of
z setting, click the setting and then click the down arrow to display the drop-
down list and select a new value. You can also click the setting and then roll
the mouse wheel to change the value or repeatedly double-click the setting to
cycle through the available values.

j’- To display the trace of any channel on the Oscilloscope, you must set the
z Visible setting for that channel to On. (You can trigger the Oscilloscope on a
channel even when Visible is set to Off.)

Channel 1 on the Oscilloscope shows the Clock signal. Channel E (External)
shows the BSG SYNC. signal, which is used as the trigger source for the
Oscilloscope. This signal goes high for one clock period at the beginning of
each sequence period. Note that the level changes of the pulses in the other
signals align with the rising edges of the clock signal.

Channel 2 shows a pseudo-random binary sequence (PRBS). With, n =4 in
the Generator Settings, the length L = 2*-1 = 15. Count the number of clock
cycles from one sync. pulse to the next to verify that this is the case. Note
that the PRBS begins to repeat at the second sync. pulse.

(RS

-,Qi To refresh and freeze the display, click the B button in the instrument toolbar.

z This refreshes the display once and freezes it. You can also press F5 or
choose View » Single Refresh. Click E_"I press F6 or choose View »
Continuous Refresh to resume normal operation.

Experiment with the Binary Sequence Generator by changing the value of n
and the Bit Rate. Adjust the Time Base on the Oscilloscope as necessary.

‘(‘2’- In order for the Oscilloscope to trigger properly, the Time Base must be set so
that at least one complete period of the Trigger Source signal is displayed on
the screen.

17
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Generator Settings:
Generation Mode ......Pseudo-Random

Logic Analyzer Settings:
Display Width.........cccocvvrvreinenne 10 ms
Clock Grid.......... ....Falli

Source Edge
Clock Edge ........
S1Data.........
S2Data s

18

9. Show the Logic Analyzer (click [B] in the toolbar or choose Instruments »
Logic Analyzer).

Click @ in the Logic Analyzer toolbar to record data. Figure 10 shows an
example of settings and what you should observe. Compare the signals as
displayed on the Logic Analyzer with the same signals as displayed on the
Oscilloscope.

Figure 10. Clock, sync. and PRBS data on Logic Analyzer.

Note that the signals displayed on the Oscilloscope and on the Logic
Analyzer are very similar. With the Logic Analyzer settings shown in
Figure 10, however, the level changes of the pulses in the Sync. signal (Bit 0)
and in the Data signal (Bit 1) align with the falling edges of the Clock signal.

Logic Analyzer operation

The Logic Analyzer does not display data in real time. Instead, after you click @,
it waits for the trigger and then begins recording data. When its memory is full, it
stops recording and displays the recorded data.

The Source setting determines which signal is used to trigger the recording and
the Source Edge setting determines whether the rising edge or the falling edge
of this signal triggers the recording.

When recording data, the Logic Analyzer samples each channel only once per
clock period. The display shows either a high level (1) or a low level (0) in the
corresponding trace for each sample taken. The Clock Edge setting determines
whether the sampling instants correspond to the rising edges or the falling edges
of the clock signal. (For this reason, the Logic Analyzer cannot display the
precise timing relationship between signals as does the Oscilloscope.)
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Generator Settings:
Generation Mode.......Pseudo-Random

Spectrum Analyzer Settings:

Maximum Input ..........ccccoveenn. 10 dBV
Scale Type......cocvvevererenenne Logarithmic
Scale .. 10 dBV/div
AVEIAGING ..oocvneerreeereereineeseeesieeineins 4

Frequency Span ...........cccc.... 2 kHz/div
Reference Frequency .........c.cccoeveune. 0
CUISOTS ...oovverrirreeeerieneeenens Vertical

© Festo Didactic 39866-10

The following sequence shows how the Logic Analyzer records data:
e The user clicks it or presses F5 or selects View » Record.

e The Logic Analyzer waits for the selected Source Edge (Rising or Falling) of
the trigger Source signal.

e The Logic Analyzer takes one sample of each channel at each selected
Clock Edge (Rising or Falling) until 256 samples of each channel have been
recorded. It then updates the display.

The Oscilloscope shows that the transitions in the DATA INPUT signal occur on
the rising edges of the clock signal. Therefore it is preferable to set Clock Edge to
Falling as this ensures that the signal will be sampled in the middle of each bit,
where the signal voltage is not changing. (Setting Clock Edge to Rising would
cause the Logic Analyzer to sample the DATA INPUT signal exactly where the
transitions occur, which could result in ambiguous values.)

To observe the output of a functional block that is falling-edge triggered, as
indicated by the symbol ‘@‘ at the clock input, it is preferable to set Clock Edge
to Rising.

10. Show the Spectrum Analyzer (click in the toolbar or choose
Instruments » Spectrum Analyzer). Figure 11 shows an example of settings
and what you should observe. In the Generator Settings, vary the value of n
and the Bit Rate and observe the effect on the spectrum.

‘(:7’- To reduce fluctuations in the displayed spectrum, set Averaging to the number
z of consecutive spectra to be averaged. The higher the setting, the lower the
fluctuations, however, the spectrum will take longer to stabilize after a change.

Figure 11. Spectrum of a PRBS.
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Theoretically, the spectral
lines have an infinitesimal
width. On a spectrum ana-
lyzer, however, they appear
as bars or peaks. If the
spectral lines are very close
together, they are not re-
solved by the Spectrum
Analyzer and the spectrum
appears to be continuous.

20

1.

s

Q~ Use a vertical cursor, as shown in the figure, to determine the approximate
frequency of various spectral elements. You can position each cursor by
dragging it with the mouse.

Note that the spectrum of a PRBS consists of a series of lobes of decreasing
magnitude with nulls at multiples of the Bit Rate R». This makes the first-null
bandwidth equal to the bit rate.

Since the data signal is not truly random but consists of a sequence that
repeats every L =2"-1 bits, the spectrum is not continuous. Instead, it
consists of spectral “lines” spaced at frequencies that are multiples of
% = an where T is the period of the sequence in seconds.

2" -1

In the generator Settings, set the Generation Mode to User Entry. Enter
different binary sequences in the Binary Sequence setting and observe the
result using the virtual instruments.

NP

Q~ When the Generation Mode is set to User Entry, the Binary Sequence
Generator generates a repeating binary sequence defined by the Binary
Sequence setting. You can enter up to 32 binary digits (1s and 0s) in this
setting. You can include spaces in this setting to make the pattern more legible
(the software ignores spaces in this setting).

The Serial to Parallel Converter

12. Make the following Generator settings:

Generation Mode ..........cccovvieveiiiiiciecc e, User Entry
Binary Sequence .........cccocoeviviiiiiiiice e 1001 1000 1110 1110
Bit Rate....coovieiiii 1000 bit/s

The Serial to Parallel Converter groups the input data stream into quadbits
and sends the first dibit of each quadbit to the | Channel of the modulator and
the other dibit to the Q Channel of the modulator. Since the Serial to Parallel
Converter is not synchronized with the data, the grouping into quadbits can
start at any bit. Because the number of bits in the Binary Sequence is a
multiple of 4, there are four possible conditions:

A) The grouping starts with the first bit of the defined Binary Sequence,
giving quadbits 1001 1000 1110 1110, as they appear in the Binary
Sequence setting.

B) The grouping starts with the second bit of the sequence.

C) The grouping starts with the third bit of the sequence.

D) The grouping starts with the fourth bit of the sequence.

J? If the grouping starts with any other bit, the result is equivalent to one of the
above conditions, since the sequence repeats indefinitely.
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Logic Analyzer symbols are
hexadecimal values derived
from combinations of binary
data in selected channels.
They should not be confused
with the symbols used in
M-aray signaling.

In this manual, the channel
selections for each Logic
Analyzer symbol, and the
hexadecimal symbol values,
are shown in square brack-
ets.

© Festo Didactic 39866-10

The first row of Table 4 shows the data bits from this Binary Sequence. After
16 bits, the sequence begins to repeat. A, B, C, and D in the table represent
the four ways the data bits can be grouped into quadbits.

Complete the four Quadbit rows of this table, grouping the data bits into
quadbits in four different ways.

Table 4. Serial to Parallel Converter inputs and outputs.

DataBits |1 0 0 1 1 0 0 O 1 1 1 0 1 1 1 01 0 O
Quadbit |1 0 0 1
A
Hex 9
B Quadbit 0O 0 1 1
Hex 3
Quadbit
C
Hex
Quadbit
D
Hex

Represent each of the quadbits in Table 4 as a hexadecimal Logic Analyzer
symbol where, if the four digits of the quadbit are (bs, bz, b1, bo), the symbol
value is equal to 23 x bz + 22x b2 + 2 x b1 + bo. This will help in interpreting the
symbols displayed by the Logic Analyzer.

Channels and symbols

The Logic Analyzer display includes a Clock channel, eight data channels
Ch1 to Ch8, each of which displays the sampled binary data (1s and 0s)
from one probe, as well as two “symbol” channels S1 and $2. Each of these
symbol channels displays a series of hexadecimal numbers that result from
combining the binary data from selected data channels.

The data channels that contribute to each symbol channel are selected using
the Symbol buttons near the bottom of the screen. By default, all Symbol
buttons are up (no channels are selected). Each selected channel
contributes one bit to the hexadecimal symbol value; the most significant bit
(MSB) corresponding to the leftmost pressed-down button and the least
significant bit (LSB) corresponding to the rightmost pressed-down button.

For example, if channels [ch1, ch3, ch6, ch7] are selected for Symbol 1, the
hexadecimal values displayed in the S1 channel correspond to 23xCh1 +
22xCh3 + 2'xCh6 + 2°xCh7. In this case, since four data channels are
combined into one symbol, the symbol values can range from [0] to [F]
(00002 to 11112). If only two data channels are combined into one symbol,
the symbol values can range from [0] to [3] (002 to 112).
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—
Table 4. Serial to Parallel Converter inputs and outputs.

Data Bits 1 o0o01100O0™1T11 011 1 01 0O
Quadbit (1 0 O 1|1 0 O 0|1 1 1 01 1 1 O
A Hex 9 8 E E
Quadbit o o110 00 1|12 1 0 11 1 0 1
5 Hex 3 1 D D
Quadbit o 11 0/0 0 1 11 01 1({1 0 1 0
¢ Hex 6 3 B A
Quadbit 11000 11101 1 10 1 00
o Hex C 7 7 4
I —

13. Connect the Logic Analyzer probes as follows:

Connect the probes exactly as shown so that the Logic Analyzer will display
N7 the symbols as shown in Table 4.

Logic Analyzer probe | Connect to Signal
C TP2 CLOCK INPUT
1 TP3 BSG SYNC. OUTPUT
2 TP4 Serial to Parallel Converter input
3 TP6 Serial to Parallel Converter output (MSB)
4 TP7 Serial to Parallel Converter output
5 TP8 Serial to Parallel Converter output
6 TP9 Serial to Parallel Converter output (LSB)

[

\9'- To make it easier to connect the probes, you may wish to zoom into this region
of the diagram. To zoom in a diagram, right-click on the diagram and choose

Zoom in the context-sensitive menu. This changes the mouse pointer to .
Drag the mouse pointer up or down to zoom in or out. Another way to zoom is
to click the diagram and roll the mouse wheel.
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© Festo Didactic 39866-10

14. Record data with the Logic Analyzer and examine the data. Using the

Symbol buttons, set Symbol 1 to [ch2] and Symbol 2 to [ch3, ch4, ch5, ch6].

Examine the data displayed by the Logic Analyzer. Figure 12 to Figure 15
show the four possible conditions, depending on how the Serial to Parallel
Converter groups the data sequence into quadbits.

Click the Drop 1 Bit button once only in the modulator and perform another
recording. Ch2 and S1, the input data, will not change but the results in Ch3
to Ch6 and S2 should be different.

For each of Figure 12 to Figure 15, identify which of the four possible
conditions (A, B, C, or D) from Table 4 the figure represents.

J7 Because the Serial to Parallel Converter operates on four bits at a time, it
N introduces a slight delay in the output bit streams. The timing relationship
changes slightly after clicking Drop 1 Bit.
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Logic Analyzer Settings:

Display Width.........cccocuvrvinien. 38 ms
Clock Grid . ..Falling Edge
SOUMCE. ... Ch1
Source Edge ......c.vvvvevnivirrinene Rising
Clock Edge ... Falli
S1Data......

S2Data......ccvcvnnee

“

Figure 12. Serial to Parallel Converter input (Ch 2) and outputs (Ch 3 to Ch 6).

Figure 12 represents Condition: OA OB OC 0OD

—
Figure 12 represents Conditon: MA OB OC 0OD

Figure 13. Serial to Parallel Converter input (Ch 2) and outputs (Ch 3 to Ch 6).

Figure 13 represents Conditon: OOA 0B OC 0OD

—_—
Figure 13 represents Condition: [JA MB [OC [OD
L=
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Figure 14. Serial to Parallel Converter input (Ch 2) and outputs (Ch 3 to Ch 6).

Figure 14 represents Condition:. OA OB OC 0OD

—
Figure 14 represents Conditon: OA OB OC ™MD

Figure 15. Serial to Parallel Converter input (Ch 2) and outputs (Ch 3 to Ch 6).

Figure 15 represents Conditon: OOA 0B OC 0OD

—

Figure 15 represents Condition: [JA OB MC [OD
L=

15. Use the oscilloscope to determine the exact timing relationship of the
different signals. Since this requires observing several signals at a time, it will

be helpful to use the memory of the Oscilloscope.

\(')'- Click M1 or M2 in the instrument toolbar to store the current display in
z Memory 1 or Memory 2. Use the Memories setting to show the contents of

Memory 1, Memory 2, or both.
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Is the output of the Serial to Parallel Converter triggered by the rising edge or
the falling edge of the clock signal? Does this correspond to the symbol used
at the clock input of the Serial to Parallel Converter?

The Serial to Parallel Converter output is falling-edge triggered, as indicated
by the symbol at the clock input ‘@‘ and in the following figure.

Oscilloscope Settings:

Channel 1. 5 Vidiv BSG SYNC.
Channel 2. 5 Vidiv
Channel E.......coovvvrivieirieens 5 Vidiv
MEONES ... Both JRIRRINARRNANARINAE c-ocKweuT
Time Base...... .. 2 ms/div = = S S R
Trigger SIOpe covvvvvvoeeceeerereeeeeeeees Rising | |'_‘| | DATA INPUT
Trigger Level ... 19V L Lo
Trigger SOUCe ........cvervevierniinninne Ext
CUSOTS oo Vertical
TP6
TP7
TP8
TP9
Serial-to-Parallel Converter signal timing (Condition A).
L
D/A Converter
16. Connect the probes as follows:
Oscilloscope probe | Connect to Signal
E TP10 I-channel D/A Converter input (MSB)
1 TP11 I-channel D/A Converter input (LSB)
2 TP14 I-channel D/A Converter output
Logic Analyzer probe | Connect to Signal
C TP2 CLOCK INPUT
E TP5 Frequency Divider output
1 TP6 Serial to Parallel Converter output (MSB)
2 TP7 Serial to Parallel Converter output
3 TP8 Serial to Parallel Converter output
4 TP9 Serial to Parallel Converter output (LSB)

‘('2’- To disconnect a probe and return it to the Probes bar, you can right-click the
probe and choose Disconnect Probe in the context-sensitive menu.
Alternatively, you can double-click the probe’s place holder in the Probes bar.
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Logic Analyzer Settings:
Display Width........cccoevrninienee 20 ms
Clock Grid....

Source Edge
Clock EAge .....ocveveeeirniiniineinns
S1Data e
S2 Data ...

© Festo Didactic 39866-10

J7 The Frequency Divider divides the BSG SYNC. signal frequency in order to

generate a signal that can be used as a trigger for the Oscilloscope or the
Logic Analyzer. This is necessary when observing the Serial to Parallel
Converter output with a binary sequence having an odd number of bits. (All
pseudo-random sequences have an odd number of bits.)

Make the following Generator settings:

Generation Mode..........ccoccviviieiiiiiciiiiieeeeee User Entry
Binary Sequence ..........ccccveeiieeieiiceeeee e 0000 0100 1100 1000
Bit Rate....oovoeeieieeeee e 2000 bit/s

Record data on the Logic Analyzer and observe the signal states. Set
Symbol 1 to [ch1, ch2] and Symbol 2 to [ch3, ch4].

The outputs of the Serial to Parallel Converter should be as shown in
Figure 16, with Ch1, Ch2 and S1 changing state and Ch3, Ch4 and S2
always zero. This means that the first dibit in each quadbit of the defined
Binary Sequence is sent to the I-channel of the modulator, and the second
dibit (always 00) is sent to the Q-channel. If necessary, click the Drop 1 Bit
button and observe the signals again until the signals are as shown in
Figure 16.

TP6
TP7
TP8
TP9

Figure 16. Desired Serial to Parallel Converter outputs.

Observe the D/A Converter inputs and output on the Oscilloscope. Figure 17
shows an example of what you should see.
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Oscilloscope Settings:

Channel 1. 5 Vidiv
Channel 2..... .2 Vidiv
Channel E ... 5 Vidiv
Time Base.... 2 ms/div
Trigger: Slope ... ...Rising
Trigger: Level......oooeincniinienes ov
Trigger: SOUrCe........cvevereeunnes Ch2

You may wish to change the
Channel 2 Scale setting to
increase the precision of the

TP10

TP11

TP14

Figure 17. D/A Converter input and output signals.

Use the cursors on the Oscilloscope to determine the different D/A Converter
output voltage levels (TP14) for the different input states and enter these into
Table 5. Divide each output level by the minimum positive output level to

measurements. . .
obtain the relative levels.
\(')'- When the horizontal cursors are active, the voltage levels corresponding to the
z position of each cursor with respect to the Ch 1 and Ch 2 ground levels (as well
as the voltage difference between the two cursors) are shown in the data
below the graticule.
When the vertical cursors are active, the time position of each cursor (as well
as the time difference between the two cursors) is shown in the data below the
graticule. The voltage levels shown correspond to the levels at the
intersections of the Ch 1 and Ch 2 traces with each cursor.
Table 5. D/A Converter input states and output levels.
Input Dibit .
(TP10, TP11) Output Level (V) | Relative Level
00
01
11
10
—
Table 5. D/A Converter input states and output levels.
Input Dibit | Output Level (V) | Relative Level
00 0.45 +1
01 1.34 +3
11 -1.35 -3
10 -0.45 -1
L
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QAM Settings:
Carrier Frequency.................. 2000 Hz
Low-Pass Filters ............cooevrereennens off

Oscilloscope Settings:

Channel 1. 2 Vidiv
Channel 2....... .. 1Vidiv
Channel E....... .. 1Vidiv
Time Base...... .1 ms/div
Trigger: SIOpe ......coeeveererereennn. Rising
Trigger: Level. Y
Trigger: SOUrCe ......c.cvvureeneerernes Ch1
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Explain the operation of the D/A Converter.

The D/A Converter converts one dibit of digital data (b+, bo) signal into a four-
level analog pulse signal whose voltage levels are proportional to -3, -1, +1
and +3.

What determines the sign and the amplitude of the D/A Converter output?

The first bit (MSB) of each dibit determines the sign and the second bit (LSB)
determines the amplitude of the analog signal.

The Filters and mixers

17. Connect the Oscilloscope probes as follows.

Oscilloscope probe | Connect to Signal
1 TP16 I-channel mixer input
E TP17 I-channel carrier
TP20 I-channel mixer output

Turn the Low-Pass Filters Off. Figure 18 shows an example of what you may
observe. Then turn the Low-Pass Filters On (see Figure 19).

Figure 18. I-channel carrier, four-level data and mixer output signal (Low-Pass Filters Off).
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QAM Settings:
Carrier Frequency.................. 2000 Hz
Low-Pass Filters ..........cccouvnruunn. On

Oscilloscope Settings:

Channel 1. 2 Vidiv
Channel 2. 1 Vidiv
Channel E ..o 1 Vidiv
Time Base......... .. 1 ms/div
Trigger: SIOpe ........cccueeivinieeen. Rising
Trigger: Level......ooeineneineines ov
Trigger: SOUrCe......c.cvuerereneennes Ch1

Figure 19. I-channel carrier, four-level data and mixer output signal (Low-Pass Filters On).

Describe the relationship between the amplitude and polarity of the four-level
analog data signal and the amplitude and phase of the mixer output signal.

—

Because the mixer multiplies the carrier by the four-level analog signal, the
amplitude of the mixer output signal is proportional to the absolute value of
the amplitude of the four-level data signal, and the phase of the mixer output
signal depends on the sign of the four-level analog signal.

What is the effect of the low-pass filter on the four-level data signal and on
the mixer output signal? What is the advantage of filtering the data signal
before modulation?

—

The low-pass filter smoothes the transitions in the four-level data signal.
Since rapid changes lead to undesirable frequency components in the
modulated signal, filtering reduces the bandwidth of the modulated signal.

18. Use the oscilloscope to observe the |- and Q-channel carrier signals. How
are these signals related?

—

30

The I- and Q-channel carrier signals are in quadrature (out of phase by 90°).
If the I-channel carrier is considered to be a cosine wave, the Q-channel
carrier corresponds to a sine wave.

19. Use the Spectrum Analyzer to observe the frequency spectrum of the carrier,
the baseband four-level data signal, and the mixer output signal (see
Figure 20). Explain the relationship between the frequency spectra of these
signals.

‘('Q’- Click M1 or M2 in the instrument toolbar to store the current display in
Memory 1 or Memory 2. Use the Memories setting to show the contents of
Memory 1, Memory 2, or both.
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QAM Settings:
Carrier Frequency............... 10000 Hz
Low-Pass Filters ..........cccovvunruunn. On

Generator Settings:
Generation Mode.......Pseudo-Random

Bit Rate ......cccovvvvreriiriren. 5000 bit/s

Spectrum Analyzer Settings:

Maximum Input...........ccvvvrnee. 20 dBV
Scale Type..... .. Logarithmic
Scale.......... ... 10 dBV/div
Averaging.......

Frequency Span ....

Reference Frequency . ....0kHz
MEMONIES ... Both

Figure 20. Frequency spectrum of four-level data signal, carrier and mixer output signal.

——

QAM Settings:
Carrier Frequency.........c........ 2000 Hz
Low-Pass Filters ...........ccccnuvveenenn. On

Generator Settings:
Generation Mode.......Pseudo-Random

Oscilloscope Settings:
Channel 1...
Channel 2...
Channel E ..
Time Base
(Single Refresh)

© Festo Didactic 39866-10

The spectrum of the modulated signal resembles the spectrum of the
baseband data signal but is double-sided and is shifted up to (and centered
on) the frequency of the carrier.

The summer

20. Use the Oscilloscope to observe the signals at the input and output of the
summer (TP20, TP21, and TP22). Figure 21 shows an example.

As an option, use a conventional oscilloscope to observe the signal at the
QAM Modulator OUTPUT (refer to the RTM Connections tab of the
software).

f

| ||||'|||||I”n ||||‘|'|
||'| " "JI||"|| |'|||| Tt i ||"|"|
|||| | ||r| ||| ||||| l|||,I|”| |||| ||h|| |
||||| ||||| ||| II||| ||

I | || || |u| |I1| ||| || (al

TP20

|"| |I'| I I'I |II| |II| ||'| |n\ ||| ||||

i
] lul l,| | |||| lu ||| '

TP21

I |,

TP22

Figure 21. Summer input and output (QAM) signals.
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Exercise 1 - QAM Modulation ¢ Procedure

Describe the operation of the summer.

—

QAM Settings:
Carrier Frequency............... 10000 Hz
Low-Pass Filters ..........cccuvrrurrinnnne On

Generator Settings:
Bit Rate .....oooceererircriiinenns 4000 bit/s

Spectrum Analyzer Settings:
Maximum Input .........cccevuvennnee 20 dBV
Scale Type
Scale ...,
AVEIagINg....coeerevrereeeeeneeeeeneeeeneens
Frequency Span ........
Reference Frequency

32

21.

The summer sums the I-channel and Q-channel bi-level, bi-phase signals to
produce the QAM signal.

Use the Spectrum Analyzer to observe the spectrum of the QAM signal and
compare this with the spectrum of the DATA INPUT signal (see Figure 22).

‘Q’- To reduce fluctuations in the displayed spectrum, set Averaging to the number
of consecutive spectra to be averaged. The higher the setting, the lower the
fluctuations, however, the spectrum will take longer to stabilize after a change.

100

004

-lono

-200 4

-300

e e T by

Figure 22. DATA INPUT signal and QAM signal spectrum.
In Figure 22, identify the features that correspond to the bit rate and the

symbol rate. Express the bandwidth of the QAM signal in terms of the bit rate
and the symbol rate.
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10.0 T
Bitrate [*— —> [*— Symbol rate

004
-lono mIHHHIHHHH

-200 4

=300

R

Figure 22. Four-level (baseband) signal and QAM signal spectrum.

The nulls in the QAM signal spectrum occur at multiples of the symbol
rate Rs which is one-quarter the bit rate Rp. The first-nulls bandwidth of the
QAM signal is therefore 2Rs = Rp/2.

Explain why QAM is considered to be a bandwidth efficient modulation
technique.

QAM is bandwidth efficient because it can transmit data at four times the bit
rate over the same bandwidth as binary modulation techniques such as
BPSK.

Signal constellations

22. Connect the Oscilloscope probes as follows:

Oscilloscope probe | Test point Signal
1 TP14 I-channel D/A Converter output
TP15 Q-channel D/A Converter output

E TP5 Frequency Divider output

As an option, connect a conventional oscilloscope to the QAM Demodulator
I-CHANNEL OUTPUT and QAM Demodulator Q-CHANNEL OUTPUT (refer
to the RTM Connections tab of the software). Use the conventional
oscilloscope in the X-Y mode to observe the constellation. (The Low-Pass
filters in the QAM Modulator must be set to On.)

Make the following Generator settings:

Generation Mode..........cccooeeeeeiviiiiiieeeeeeeeeenn. Pseudo-Random
o [N 3
Bit Rate......oooeeeeeeeeeeeeee e, 3000 bit/s
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Exercise 1 - QAM Modulation ¢ Procedure

Figure 23 shows and example of what you should observe. The Oscilloscope
will display the |- and Q-channel D/A Converter output signals. Each of these
signals is a four-level analog signal that is used, after low-pass filtering, to
modulate one of the sinusoidal carriers.

Oscilloscope Settings:
Channel 1.
Channel 2.
Time Base....... .
Trigger Slope ..
Trigger Level...
Trigger Source

Figure 23. I- and Q-channel D/A Converter output signals.

23. Without moving the Oscilloscope probes, put the Oscilloscope in the X-Y
mode. Figure 24 shows an example of what you should observe.

Oscilloscope Settings:

Channel 1 (X)...ooveverereererienene
Channel 2 (Y)..
Display Mode ..
XY s

Figure 24. QAM constellation (7 points shown).

N

;Q’- The Sampling Window setting determines the time during which the signals
z are sampled before each update of the display. In the present case, this should
be 100 ms or greater so that all quadbits being generated appear each time
the display is updated.
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Exercise 1 — QAM Modulation ¢ Procedure

The Oscilloscope now displays a number of points in the signal constellation.
What does each point in the constellation represent?

—
Each point displayed in the constellation corresponds to a one signal state,

that is, to one combination of phase and amplitude. Each signal state
corresponds to a different quadbit (pattern of four bits) in the input data
stream.

With 16-QAM, the constellation should normally have 16 points. Why are
only 7 points displayed?

With the Generator Setting n set to 3, only 7 of the 16 constellation points are
used. This is due to the fact that the Pseudo-Random Binary Sequence is
relatively short and therefore the number of different quadbits in the data is

limited.
[

24. In the Generator Settings, set n to different values (2, 4, and 5, etc.) and
observe the displayed constellation. What do you observe?

—
The longer the Pseudo-Random Binary Sequence, the greater the number of

different quadbits in the data and the greater the number of constellation
points displayed. When the Pseudo-Random Binary Sequence is long
enough, all 16 constellation points are included.

25. Connect the Logic Analyzer probes as follows:

Logic Analyzer probe | Connect to Signal
C TP2 CLOCK INPUT
1 TP3 BSG SYNC. OUTPUT
2 TP4 Serial to Parallel Converter input
3 TP6 Serial to Parallel converter output (MSB)
4 TP7 Serial to Parallel converter output
5 TP8 Serial to Parallel converter output
6 TP9 Serial to Parallel converter output (LSB)

26. Set the Generation Mode to User-Entry. Set the Binary Sequence to the four-
bit sequence (quadbit) 0000 and the Bit Rate to 2000 bit/s. Record data
using the Logic Analyzer. Configure Symbol 2 of the Logic Analyzer to
display the hexadecimal value of the quadbit, as shown in Figure 25.
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Exercise 1 - QAM Modulation ¢ Procedure

Logic Analyzer Settings:

Display Width.........cccocvvvvinienee 10 ms
Clock Grid . ..Falling Edge
SOUMCE. ... Ch1
Source Edge ......c.vvvveviniririnens Rising
Clock Edge ... Falli
S1Data......

S2Data......ccvewnnee

With any four-bit Binary
Sequence, the stream of
quadbits at the output of the
Serial to Parallel Converter is
uniform over time — each
quadbit is identical to the
previous quadbit.

36

Figure 25. Logic Analyzer showing the quadbit 0000 in Ch 3 to Ch 6 and in S2.
Observe the Oscilloscope display. Figure 26 shows the constellation point
corresponding to the quadbit 0000. Note in Figure 27 that this constellation

point has been identified with the quadbit it represents as well as the
hexadecimal value of the quadbit in square brackets.

Y--

Figure 26. Oscilloscope showing the constellation point for the quadbit 0000.
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LSDs:
(] (] (] (]
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MSDs: __

Figure 27. Quadbits [and HEX values] in the QAM constellation.

27. Set the Binary Sequence to 1111 and repeat the previous step. You have
now identified two of the 16 points in the constellation. In the following steps,
you will identify the remaining points.

Identifying constellation points

Identifying the constellation points that are mapped to 0000 and 1111 is
straightforward because with each of these Binary Sequences, the four outputs
of the Serial to Parallel Converter are identical. The bit at which the Serial to
Parallel Converter begins to divide the DATA INPUT stream makes no
difference.

With all other four-bit Binary Sequences, however, the bit at which the Serial to
Parallel Converter begins does make a difference. For example, setting the
Binary Sequence to 0001 will produce a uniform stream of one of the following
quadbits: 0001, 0010, 0100, or 1000. There is no way to predict beforehand
which of these quadbits you will obtain. Clicking the Drop 1 Bit button allows you
to change the quadbit produced.
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38

In the following steps, for each four-bit Binary Sequence you enter, you will use
the Logic Analyzer to observe which quadbit is present at the output of the Serial
to Parallel converter, and observe which constellation point is displayed on the
Oscilloscope. Then you will use the Drop 1 Bit button to obtain all possible
quadbit from that Binary Sequence.

28. Set the Binary Sequence to 0001. Record data on the Logic Analyzer and
note which quadbit is present at the outputs of the Serial to Parallel
Converter. Since TP6 represents the MSB, a 0 at TP6, TP7 and TP8 and a 1
at TP9 represents the quadbit 0001. Clicking the Drop 1 Bit button will
change this quadbit to 0010.

Click the Drop 1 Bit button several times, each time observing the quadbit
using the Logic Analyzer and observing the constellation point displayed on
the Oscilloscope. Then write in Figure 27 the quadbits that correspond to
these four constellation points.

By using different four-bit Binary Sequences and the Drop 1 Bit button, and
by using the Logic Analyzer and the Oscilloscope, complete Figure 27 to
show all 16 quadbits. Enter the hexadecimal value of each quadbit between
the square brackets.

Each quadbit consists of two dibits — the most significant dibit (MSD) and the
least significant dibit (LSD). Below the horizontal axis of Figure 27, write the
MSDs that correspond to each of the columns. To the right of the vertical
axis, write the LSDs that correspond to each of the rows.

© Festo Didactic 39866-10



Exercise 1 — QAM Modulation ¢ Procedure

© Festo Didactic 39866-10

LSDs:

( ( ( (
1101 1001 0001 0101 01
[D] [9] [1] [5]

( ( ( (
1100 1000 0000 0100 00
[C] (8] (0] (4]

( ( ( (
1110 1010 0010 0110 10
[E] [A] (2] (6]

{ ( ( (
1111 1011 0011 0111 11
[F] [B] (3] (7]

MSDs: 11 10 00 01
Figure 27. Quadbits [and HEX values] in the QAM constellation.

| —

Note the order of the MSDs and the LSDs. Are they arranged consecutively?

The MSDs and LSDs are not arranged consecutively since 00 comes
between 10 and 01.

The smallest distance between neighboring constellation points is the
horizontal or vertical distance between consecutive points. Constellation
points separated by this distance are considered to be adjacent. (The oblique
distance between any two points is greater than this distance.) Note how the
bits values of the quadbits change as you move from one point to any
adjacent point.

Name the type of coding that is used here and explain the advantage of
encoding the constellation points in this manner.

—

Moving from any constellation point to an adjacent point changes only one bit
in the quadbit. This is an example of a Gray code, where two adjacent values
differ in only one digit. The advantage of a Gray code is that when noise in
the transmission channel causes a constellation point to deviate into the
region of an adjacent point, only one bit is in error. When Gray coding is
combined with an error correction mechanism capable of correcting single-bit
errors, the transmission is less susceptible to noise.
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CONCLUSION

REVIEW QUESTIONS

40

29. Enter the three-bit Binary Sequence 111 and observe the constellation.

Change the binary Sequence to 101. Click the Drop 1 bit button several
times and observe what happens.

Explain why this 3-bit sequence produces three constellation points, each of
which represents four bits and why the drop 1 bit button seems to have no
effect.

—

The number of bits in this sequence is not a multiple of four. Since the Serial
to Parallel Converter groups bits four at a time, the sequence must pass four
times before the system returns to its initial state (101 101 101 101). The
quadbits sent to the modulator are therefore 1011 0110 and 1101. These
three points appear in the constellation. Dropping one bit does not change
the quadbits that this sequence produces.

30. When you have finished using the system, exit the LVCT software and turn

off the equipment.

In this exercise, you became familiar with the LVCT software and studied the
operation of the basic functional blocks of the QAM modulator. You observed that
the Serial to Parallel Converter groups the input data stream into quadbits that
are processed by two parallel channels, | and Q, and that the starting point of this
grouping is arbitrary. You saw how the A/D Converters and the mixers generate
two bi-phase, bi-level signals using two carriers in phase quadrature. You
observed that summing these two signals produces the QAM signal. You also
observed the signal constellations on the oscilloscope for various binary
sequences.

1.

Explain what is meant by bandwidth efficiency.

Bandwidth efficiency is a measure of how efficiently a modulation technique
uses the available bandwidth. It is equal to the maximum theoretical number
of bits per second that can be transmitted per unit bandwidth.

2. How does the bandwidth efficiency of QAM compare to that of other

modulation techniques?

The bandwidth efficiency of QAM is twice that of QPSK and four times that of
binary modulation techniques such as BPSK.
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3. What does a constellation diagram represent?

—
The constellation diagram is a pictorial representation showing all possible

signal states as a set of constellation points in the [-Q plane. Each
constellation point corresponds to the head of a phasor and represents one
of the symbols used by the modulation scheme. Its position in the diagram
shows the amplitude and the phase of the corresponding waveform.

4. What is the role of the mixers in the QAM modulator?

—
Each mixer performs modulation by multiplying the sinusoidal carrier by the

four-level baseband data signal. The effect of the mixer is to shift the
frequency spectrum of the baseband signal up to the frequency of the carrier.

5. How are the signals at the outputs of the mixers combined to produce the
QAM signal?

The I- and Q-channel mixer output signals are simply summed in order to
produce the QAM signal.
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